
MU Beta

Hardwarový emulátor

mikrokontrolérů Microchip PIC

Uživatelská příručka



OBSAH:

  1. MU Beta 3
   1.1 Technické parametry 3
   1.2 Obsah dodávky 3

  2. Instalace hardware 4

  3. Používání hardware 5

  4. Instalace software 6

  5. Jak začít 7

  6. Další informace 8

  7. Kontakt 8

Strana 2 / 8



1. MU Beta
MU  Beta  je  hardwarový  emulátor  pro  nejpopulárnější  mikrokontroléry 
Microchip řady PIC12 a PIC16 s 6 až 18 vývody do 2 kiloword paměti programu 
včetně typů s A/D převodníkem a analogovými komparátory.

K dispozici  je  integrované  vývojové  prostředí  IDEA  pro  Windows 
95/98/ME/2K/XP/Vista.

Aktuální  seznam  podporovaných  součástek,  nejnovější  software  a  případné 
další důležité informace jsou dostupné na www.asix.cz.

1.1 Technické parametry
Připojení k PC: standardní paralelní port (LPT) nebo USB (pomocí EMUSB)

• Napájení: 9 V stejnosměrných, 300 mA
• Rozměry: 13,5 × 6,5 × 3 cm
• Rozsah provozních teplot: +10° až +40°C
• Maximální přípustná relativní vlhkost prostředí: 90 %

1.2 Obsah dodávky

MU Beta Základní jednotka emulátoru
BT CABLE Kabel pro připojení  k PC: 25-pinový konektor k paralelnímu 

portu (LPT), 9-pinový konektor k MU Beta
Pozn.: Pro použití s USB je BT CABLE nahrazen rozhraním EMUSB.

PROTAB Prostředek pro ochranu vývodů emulátoru - připojuje se ke
konektoru TARGET

HMUB8 Emulační hlavice pro PIC12C5xx (8 pinů): modul
HMU10F2xx Emulační hlavice pro PIC10F2xx (6 pinů): modul
HMU12F6xx Emulační hlavice pro PIC12F6xx (8 pinů): modul
HMU16F6xx Emulační hlavice pro PIC16F6xx (14 pinů): modul
HMU10 Emulační hlavice pro 6 / 8-pinové typy: kabel s paticí
HMU16 Emulační hlavice pro 14-pinové typy: kabel s paticí
HMU20 Emulační hlavice pro 18-pinové typy: kabel s paticí
CD-ROM ASIX Kompletní elektronická příručka, instalační soubor pro

ovládací software a další informace
MW903GS Napájecí zdroj
MANMUBETA Tato uživatelská příručka
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2. Instalace hardware
• Vypněte počítač, ke kterému budete emulátor připojovat.
• Připojte komunikační kabel - jsou dvě možnosti:

• Paralelní port
Zapojte  kabel  BT  CABLE (Sub-D  25 ↔ 9  pinů)  do  konektoru  emulátoru 
označeného LPT a do paralelního portu počítače.

• USB (pomocí doplňku EMUSB)
Připojte EMUSB k USB portu počítače nebo k USB hubu. Windows nalezne nový 
hardware a požádá o instalaci ovladačů - ty jsou dostupné na instalačním CD a 
na www.asix.cz. Postupujte standardním způsobem. Při informaci, že ovladače 
nejsou  digitálně  podepsány,  vyberte  volbu  „Continue  anyway“.  Po  úspěšné 
instalaci bude svítit zelená LED. EMUSB pak připojte k MU Beta.

• Zapojte napájecí adaptér do konektoru označeného  9V DC na emulátoru a 
pak připojte adaptér k síti. Napájení je indikováno zelenou LED označenou 
POWER (viz Pozn. 1).

• Zasuňte ochranný modul  PROTAB do konektoru  TARGET na emulátoru (viz 
Pozn. 2).

• Zapojte  emulační  hlavici  příslušnou  pro  typ  součástky,  se  kterou  chcete 
pracovat, do modulu  PROTAB a do patice pro mikrokontrolér v aplikaci. Pin 
číslo 1 je označen červenou tečkou (viz Pozn. 3, 4 a 5).

• Zapněte počítač.

Poznámky:
1. MU  Beta nemá  vypínač  napájení.  Nenechávejte  emulátor  připojený 
k napájení, pokud jej delší dobu nepoužíváte. I při odpojeném napájení může 
emulátor zůstat připojený k paralelnímu portu počítače.

2.  Vždy,  pokud  to  je  možné,  používejte  ochranný  modul  PROTAB mezi 
emulátorem a  emulační  hlavicí.  Jeho  účelem je  zamezit  zničení  výstupních 
budičů emulátoru při případném zkratu na výstupu. Výstupní budiče emulátoru 
jsou  totiž  schopny  poskytnout  poměrně  značný  proud  (pro  dosažení 
kompatibility s reálným mikrokontrolérem PIC), avšak zkrat mezi výstupem a 
zemí  či  napájením  může  způsobit  trvalé  zničení  výstupních  obvodů.  Bez 
modulu  PROTAB by  měly  být  emulovány  pouze  aplikace,  které  skutečně 
vyžadují plný výstupní proud vývodu PIC, ale i  v tomto případě by měl být 
modul PROTAB použit na začátku práce, když ještě nemusí být okolní hardware 
zcela v pořádku.

3. Použití emulačních hlavic pro různé typy PIC:

Součástka Emulační hlavice
Všechny 18-pinové typy HMU20
PIC10F2xx HMU10F2xx + HMU10
PIC12C50x HMUB8 + HMU10
PIC12F6xx HMU12F6xx + HMU10
PIC16F6xx HMU16F6xx + HMU16
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4.  Emulační hlavice obsahuje patici určenou ke vložení do aplikace na místo 
emulovaného PIC a dva háčky označené TriggerIn a TriggerOut, které jsou 
popsány níže.

5. Standardní  emulační  hlavice  podporují  součástky  v  pouzdrech  DIP. 
Konvertory DIP ↔ SOIC (XLT08SO a XLT18SO) lze dokoupit zvlášť. 

3. Používání hardware
• Emulátor  MU  Beta je  určen  k provozování  v běžných  kancelářských  či 

laboratorních  podmínkách.  Zamezte  jeho  vystavení  nadměrné  vlhkosti, 
prachu,  nečistotám  a  atmosféře  s nebezpečím  výbuchu.  Neprovozuje 
emulátor mimo rozsah teplot +10° až +40°C. Skladovací teplota může být 
v rozsahu od -10° do +60°C. Není povoleno snímat kryt emulátoru. 

• Emulátory  nejsou  určeny  k přímému  připojení  k elektrovodné  síti. 
Používejte  vždy  napájecí  adaptér,  který  byl  dodán  spolu  se 
zařízením. Adaptér nesmí být poškozen.

• Vždy, když chcete odpojit emulátor od počítače, vypněte emulátor i počítač.
• Používejte  vždy  jen  komunikační  kabel,  který  byl  součástí  dodávky. 

Používejte  vždy  jen  funkční  paralelní  port  PC  (popř.  USB  s  rozhraním 
EMUSB), nepokoušejte se připojit emulátor k jinému typu portu PC.

• Napájecí napětí přípustné pro emulovanou aplikaci je 0 až 5,5 V. Jestliže je 
pin emulované součástky nakonfigurován jako výstup,  nesmí kolidovat se 
signálem z cílové aplikace a nesmí dojít  ke zkratu mezi  tímto vývodem a 
napájecím  napětím  či  zemí.  Nedodržení  těchto  pokynů  může  vést 
k vážnému poškození emulátoru!

• Používejte ochranný modul  PROTAB vždy, když to je možné! Vložte 
PROTAB mezi emulátor a emulační hlavici. Jediným důvodem pro odpojení 
modulu PROTAB je to, že potřebujete využít plný výstupní proud emulované 
součástky, což je poměrně řídký případ.

• Připojujte  a  odpojujte  emulační  hlavici  zásadně  s vypnutým 
napájením cílové aplikace!

• Není  nutné vypínat  napájecí  napětí  aplikace  ani  při  vypnutém emulátoru. 
Jádro  emulátoru  a  vstupně-výstupní  obvody  připojené  k aplikaci  mají 
oddělené napájení, společný je pouze zemní vodič. Naopak - jádro emulátoru 
může pracovat i při odpojeném napájení aplikace, vstupy a výstupy ovšem 
samozřejmě nebudou pracovat.

• Signál  TriggerOut je  výstup.  Nesmí  být  přetížen,  např.  zkratem  do 
napájení či země.

• Signál TriggerIn je digitální vstup. Rozsah vstupních napětí je 0 až 5,5 V.
• Emulační  hlavice by  měla  být  chráněna  před  poškozením.  Aby  se 

prodloužila  její  životnost,  je  doporučeno  nasadit  na  emulační  patici  ještě 
obyčejnou levnou patici  DIP,  která  může být  v případě poškození  snadno 
vyměněna. Emulační hlavice jsou od výrobce takto dodávány.
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4. Instalace software
Při použití EMUSB (USB rozhraní pro MU Beta) napřed nainstalujte ovladače.

Stáhněte si instalační soubor z www.asix.cz nebo použijte instalační CD-ROM 
ASIX a spusťte instalační program idea_xxxx.exe, kde pod označením "xxxx" 
se  rozumí  číslo  verze.  Instalace  používá  obvyklý  instalátor  s 
"pomocníkem" (konkrétně program InnoSetup).

Výchozí instalační adresář (složka) je C:\Program Files\ASIX\IDEA. Pokročilí 
uživatelé mohou použít i jiný adresář než "C:\Program Files". Ikona programu 
bude standardně umístěna na pracovní plochu, ale tuto možnost lze i zakázat.
 
Nyní  můžete  poprvé  spustit  program  IDEA.EXE.  Uživatelé  Windows 
NT/2K/XP/Vista to musí učinit v režimu s právy administrátora, protože bude 
instalován  ovladač  paralelního  portu  asixio.sys (typicky  do 
C:\Windows\System32\Drivers).  Dále  je  nutné  zajistit  právo  pro  zápis  do 
adresáře, kde je umístěn program IDEA.EXE, aby zde mohl být umístěn soubor 
s globálními parametry IDEA.INI.

Může rovněž být užitečné asociovat  souborovou příponu .IDP s  programem 
IDEA, protože to umožní spouštět projekty pomocí souborových manažerů jako 
např. Total Commander, ZTreeWin, FAR či Průzkumník.
 
Poznámky:
1. Pokud  máte  nainstalovánu  předchozí  verzi  programu  IDEA,  před  novou 
instalací  ji  napřed  odinstalujte.  Budou  tím  odstraněny  staré  nepotřebné 
soubory.  Vaše  projekty  a  zdrojové  soubory  zůstanou  zachovány,  přepsány 
budou pouze soubory {IDEA}\Projects\Examples\Example.* s příklady. 

2. Musí být zajištěno právo zápisu do adresářů (složek), kde je nainstalován 
program IDEA a do adresářů, kde jsou uloženy projekty. Nelze tedy spouštět 
software  např.  z  CD-ROM.  Nastavení  v takovém případě nebudou moci  být 
uložena na disk a software bude hlásit chybu.

3. Software  IDEA vyžaduje správné nastavení data a času na počítači. 
IDEA srovnává časovou informaci zdrojových souborů (např.  .ASM) a souborů 
pro  ladění  aplikace  (.COD)  a  rozhoduje  se,  zda  zdrojové soubory  musí  být 
přeloženy před tím, než bude informace z ladicího souboru použita.

4. Kromě případné instalace ovladače se program IDEA instaluje  pouze do 
instalačního adresáře a nezamořuje systémové adresáře žádnými novými či 
pozměněnými soubory. Nemění se ani registry systému Windows (s výjimkou 
informací zapisovaných instalačním programem, které nesouvisí s činností či 
nastaveními programu IDEA).
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5. Jak začít
Krok 1.
Nainstalujte hardware MU Beta podle návodu v kapitole 2. Instalace hardware.

Krok 2.
Nainstalujte  software  IDEA  podle  návodu  v  kapitole  4.  Instalace  software. 
Uživatelé Windows NT/2K/XP musí být při prvním přístupu k hardware v režimu 
s právy  administrátora,  bude  totiž  automaticky  nainstalován  ovladač.  Při 
dalších spuštěních programu IDEA už stačí práva běžného uživatele.

Krok 3.
Je-li  hardware  i  software  správně  nainstalován  a  emulátor  je  připojen 
k napájení, spusťte program IDEA, např. dvojitým kliknutím na jeho ikonu na 
pracovní ploše. Nejprve je automaticky spuštěn překladač MPASMWIN, který 
vytvoří potřebný ladicí soubor pro ukázkový projekt "Example". Poté budete 
vyzváni, abyste zvolili následující akci. Vyberte výchozí volbu "Continue to use 
an EXAMPLE project" kliknutím na příslušné tlačítko. Bude zobrazena pracovní 
plocha programu IDEA s okny Program memory (paměť programu) a Console 
(konzole - slouží k přehledu o prováděných operacích). 

Krok 4.
Nyní je nutné nastavit komunikaci s hardware. V nabídce programu vyberte 
Options → Global,  bude  otevřen  dialog  Global  Options.  Potom  vyberte 
záložku  MU Beta a  nastavte  komunikační  parametry.  Typické  nastavení  je 
LPT1, jako bázová adresa bude zobrazena typicky hodnota 0378h.

Krok 5.
Nastavte typ zařízení v projektu na MU Beta: Volbou Project → Edit Project 
otevřete  dialog  Edit  Project a  změňte  nastavení  zařízení  (equipment) 
z výchozího nastavení DEMO na MU Beta. Neměňte typ součástky (part type)  -
PIC16F84A. Potvrďte kliknutím na tlačítko OK, pak vyberte Yes jako odpověď 
na další  dotaz.  Projekt  bude přeložen  assemblerem MPASMWIN,  poté  bude 
inicializován  hardware  emulátoru  (proběhne  konfigurace  FPGA  a  nastavení 
parametrů). Diody LED jsou nyní aktivní a indikují stav hardware. 

Krok 6.
Na  pracovní  plochu  programu  IDEA  umístěte  nové  okno  -  Watches,  které 
ukazuje  hodnoty  zvolených  proměnných.  Provedete  to  pomocí  menu 
View → Watches. Zobrazí se proměnné HUNDREDS, SECONDS, MINUTES a 
HOURS (setiny sekund, sekundy, minuty a hodiny). 

Poté spusťte běh aplikace povelem z menu Run → Run. Aplikační program se 
rozběhne,  a  hodnoty  proměnných  se  budou  příslušně  zvyšovat.  Tato 
jednoduchá aplikace nepřistupuje k portům mikrokontroléru, takže k emulační 
hlavici nemusíte mít připojenu žádnou hardwarovou aplikaci ani její napájecí 
napětí. 
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Nyní  si  můžete  s  projektem  "hrát"  -  pomocí  příkazů  Run (běh),  Halt 
(zastavení),  Step (krokování  po  jednotlivých  instrukcích),  Edit  source 
(editace  zdrojového kódu v  editoru WE),  Build (překlad  zdrojového  kódu), 
zavírat a otvírat různá okna, atd. 

6. Další informace
[1] http://www.asix.cz

[2] http://www.microchip.com

7. Kontakt
Adresa: ASIX s.r.o.

Staropramenná 4
150 00 Praha 5 - Smíchov

Tel.: 257 312 378

Fax: 257 329 116

E-Mail: asix@asix.cz

WWW: www.asix.cz

MU-BETA_CZ, 2008-06-27

All rights reserved. Copyright  1991-2008, ASIX s.r.o.

All  trademarks  used  in  this  document  are  properties  of  their  respective  owners.  This 
information  is  provided  in  the  hope  that  it  will  be  useful,  but  without  any  warranty.  We 
disclaim any liability  for  the  accuracy  of  this  information.  We are  not  responsible  for  the 
contents of web pages referenced by this document.

Strana 8 / 8

http://www.asix.cz/
mailto:asix@asix.cz

	2. Instalace hardware
	3. Používání hardware
	4. Instalace software
	5. Jak začít
	6. Další informace
	7. Kontakt

